
Caracterizarea dielectricilor solizi prin spectroscopie dielectrica 

 

 

1. Scopul lucrării  

 

Scopul general al acestei lucrări este de a studia comportamentul dielctric al unor 

dielectrici solizi sub forma de placi prin spectroscopie dielectrică. 

 

2. NoŃiuni teoretice 

 

Spectroscopia dielectrică este o tehnica moderna de analiza a interactiunii dintre un 

material si campul electric care actioneaza asupra sa. Aceasta metoda este larg utilizata pentru 

diagnosticarea starii dielectricilor din sistemele de izolatie si pentru detectarea imbatranirii 

acestora, precum si pentru analiza raspunsului dielectric al noilor materiale in scopul 

determinarii celor mai potrivite aplicatii pentru aceste materiale. Spectroscopia dielectrica are 

la baza fenomenele de polarizare electrică şi de conducŃie electrică din materiale. Este bine 

cunoscut faptul ca la nivel microscopic sau molecular exista diferite mecanisme de polarizare. 

Fiecare din aceste mecanisme este caracterizat de o frecventa proprie de rezonanta si de 

relaxare dielectrica (Fig.1). 

Cele mai importante mecanisme pot fi împarŃite în trei categorii principale: 

• Polarizarea electronică este prezenta in materiale pana la frecvente optice si se realizeaza 

printr-o uşoară deplasare a norului electronic al fiecărui atom în raport cu nucleul.  

• Polarizarea ionică este datorată deplasării ionilor într-o moleculă sau matrice si se 

manifesta pana la frecvente de infraroşu.  

• Polarizarea de orientare apare atunci când unele grupări moleculare prezintă un moment 

electric permanent, orientat aleatoriu în spaŃiu, dar care în momentul aplicării câmpului 

electric tinde să se orienteze în sensul acestuia, rezultând astfel o polarizare în această 

direcŃie. Rata de orientare a dipolilor se află în strânsă dependenŃă cu interacŃiunile inter- 

si intra-moleculare. Orientarea dipolilor poate apărea deci într-un domeniu larg de 

frecvenŃe in domeniul de frecvente radio, depinzând de uşurinŃa cu care dipolii se 

orientează sub actiune campului electric. 
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Fig.1. Variatia compenentelor reala si 

imaginara ale permitivitatii complexe cu 
frecvenŃa campului electric 

Fig.2. Tehnici de spectroscopie dielectrica in 
functie de domeniul de frecventa studiat. 

 

Determinarile experimentale din cadrul prezentei lucrari se efectueaza utilizand un 

spectrometru dielectric NOVOCONTROL, ale carui elemente principale sunt unitatea 

centrala Alpha-A High Performance Frequency Analyzer si celula de masura ZGS.  Acest 

spectrometru este construit în special pentru analiza materiale dielectrice cu impedanŃă mare 

şi factor de pierderi foarte mic, într-un domeniu foarte larg al frecvenŃei (3 µHz ÷ 20 MHz), 

dar poate măsura destul de precis materiale de conductivitatea mare şi impedanŃa electrică 

mică. 

 
Fig.3. Unitatea centrală Alpha-A a spectrometrului dielectric NOVOCONTROL şi celula ZGS 

 

Eşantionul de incercat se monteaza în celula din fig.3, între cei doi electrozi ce formează 

cu materialul de măsurat un condensator. O tensiune U(t) de amplitudine U0 se aplică 

condensatorului între armăturile căruia se află eşantionul, pentru o frecvenŃă fixată πω 2/ . 
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Această tensiune determină apariŃia prin eşantion a unui curent de intensitate I(t) cu 

amplitudinea I0, de aceeaşi frecvenŃă. DiferenŃa de fază între curent şi tesniune este descrisă de 

unghiul de fază φ. RelaŃiile dintre tensiune, curent şi defazajul φ sunt determinate de 

proprietăŃile electrice ale eşantionului (permitivitatea electrică şi conductivitate electrică) 

precum şi de structura materialului. Pentru calculul mărimilor corespunzătoare proprietăŃilor 

analizate se utilizează următoarele relaŃii: 
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Pentru un eşantion cu un răspuns electromagnetic liniar, impedanŃa măsurată pentru un 

condensator între armăturile căruia se află eşantionul este: 
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Determinarea impedantei permite determinarea permitivitatii complexe si a conductivitatii 

complexe, utilizand relatiile (6) si, respectiv (7):  
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unde 0C este capacitatea condensatorului cu vid intre armături, d – grosimea esantionului, iar 

A – aria electrozilor. 

Setarea aparatului se va realiza cu ajutorul soft-ului WinDETA realizat tot de 

NOVOCONTROL. WinDETA reprezintă un pachet de programe ce poate controla complet 

măsurătorile realizate asupra componentelor, eşantioanelor şi interfeŃelor, cu ajutorul acestui 

sistem electric performat. Rezultatele obŃinute sunt evaluate, afişate şi exportate în alte 

programe în diferite moduri. 
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3. Chestiuni de studiat 

 

3.1. Determinarea variaŃiilor permitivităŃii electrice şi ale factorului de pierderi cu 

frecvenŃa pentru diferite materiale izolante solide sub formă de placi. 

3.2. Analizarea rezultatelor obŃinute şi evidentiarea fenomenelor care au loc in 

materialele studiate la diferite frecvente. 

 

4. Determinări experimentale 

 

4.1. Fixarea eşantionului 

Înainte de pornirea spectrometrului, eşantionul se montează în celula din fig.4, între cei 

doi electrozi ce formează cu materialul de măsurat un condensator. În acest scop se roteşte 

şurubul de fixare (fig.4). Atât eşantionul, cât şi cei doi electrozi ai condensatorului trebuie 

curăŃaŃi cu alcool etilic, anterior montării, pentru îndepărtarea impurităŃilor şi obŃinerea unor 

rezultate cât mai exacte. 

 

  
Fig.4. Celula ZGS a spectrometrului dielectric Alpha-A Analyzer 

 

4.2. Pornirea instrumentelor de măsură şi control 

a) Se porneşte calculatorul conectat la unitatea centrala (Alpha-A Analyzer) a spectrometrului 

dielectric. 

b) Se porneşte unitatea centrală a spectrometrului dielectric Alpha-A High Performace 

Frequency Analyzer de la butonul On/Off.  

c) Se porneşte sistemul MICROTRONIC de control al temperaturii. 



 5 
 

d) Se porneşte aplicaŃia software WinDETA. În momentul pornirii acestei aplicaŃii se 

iniŃializează toate setările implicite din fişierul DEFAULT.pre (aflat în Program 

Files\Novocontrol\WinDETA). În cazul în care anterior au fost salvate alte setări (specifice 

unor anumite tipuri de analize), acestea pot fi încărcate în locul celor implicite din meniul 

File→Load Preset file. Descrierea salvărilor setărilor pentru un anumit tip de analiză se 

face in cadrul paragrafelor 4.7. şi 4.9.  

 

4.3. Configurarea instrumentelor de măsură 

a) Din meniul Analyzer (fig.5) se selectează din listă analizorul utilizat, în cazul nostru 

ALPHA or BETA Analyzer. Analizorul poate fi configurat din meniul Analyzer→ 

Options→ Configuration. 

b) În vederea monitorizării setării sistemului de măsură, din meniul Window se bifează 

opŃiunile Status şi apoi Tile (fig.6). 

c) Pentru a indica analizorului care este controlerul de temperatură utilizat, din meniul 

Temp. Controller se selectează Use Novotherm (fig.7.). 

 

Fig.5. Setarea analizorului 
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Fig.6. Configurarea ferestrelor pentru monitorizarea setărilor sistemului de măsură 

 

 

Fig.7. Setarea controlerului de temperatură 
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4.4. Descrierea caracteristicilor eşantionului de măsură 

 

Din meniul Measurement se selectează Sample Specification pentru a introduce un 

comentariu măsurătorii (Sample Comment: PEJD), ca în fig.8. Pentru celula corespunzătoare 

materialelor dielectrice, formată dintr-un condensator plan se completează diametrul (Sample 

Diameter [mm] = 40) şi grosimea eşantionului (Sample Thickness [mm] = 0,5). În funcŃie 

de valorile introduse, softul WinDETA calculează automat capacitatea specifică a 

condensatorului C0 [F]. Aceste valori influenŃează estimarea valorilor absolute ale 

permitivităŃii electrice şi ale conductivităŃii specifice.  

 

Fig.8. Descrierea caracteristicilor eşantionului 

 

4.5. Stabilirea ordinii utilizării variabilelor independente 

 

 Din meniul Measurement se selectează List Order. Pentru cazul particular al PEJD, 

din lista de variabile independente (Available) se selectează frecvenŃa şi apoi temperatura, 

care se adaugă (Add) în lista Order (fig.9). 
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În continuare, se introduc valori pentru variabilele selectate anterior. Astfel, pentru 

setarea valorilor frecvenŃelor la care se fac măsurătorile, din meniul Measurement se 

selectează Value Lists şi apoi Frequency. Pentru setarea domeniului de frecvenŃă se 

selectează Points din fereastra List of  Measurement Points (fig.10) şi se introduc limitele 

Start şi End. De asemenea se stabileşte modul de repartizare al punctelor pe grafic, fie într-o 

progresie aritmetică (linear), fie în progresie geometrică (logarithm), stabilind un increment 

(Increment) sau un factor de multiplicare (Factor). Această listă de puncte se poate adauga la 

o lista deja existentă (Add To List) sau poate înlocui o altă listă (Replace List). 

În exemplul parcurs în cadrul acestei lucrări, cel al PEJD se selectează domeniul de 

frecvenŃă 10+1 ÷ 10-1 Hz pe o scară logaritmică de Factor 10. Numărul de puncte afişate în 

final pe grafic va fi de 3.  

 

ObservaŃie: Domeniul de frecvenŃă al spectrometrului dielectric este cuprins între 3 µHz şi 20 MHz. 

Pentru valori scăzute ale frecvenŃei, timpul necesar realizării măsurătorilor va fi mult mai mare decât 

în cazul frecvenŃelor mari.  
 

 

Fig.9.  Lista variabilelor independente 
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Fig.10. Setarea  domeniului de frecvenŃă 

 

Pentru setarea valorii (sau valorilor) de temperatură la care se efectuează măsurătorile, 

se selectează din meniul Measurement opŃiunea Temperature. În acestă lucrare se utilizează 

o singură valoare a temperaturii (în cazul nostru 300 K) care se introduce în căsuŃa 

Temperature din fereastra List of  Measurement Points (fig.11). Temperatura se stabileşte 

în Kelvin prin debifarea opŃiunii Temperature Unit [°C]. Pentru mai multe valori ale 

temperaturii se procedează ca şi în cazul frecvenŃei, utilizând opŃinea Points. 

 

4.6. Configurarea WinDETA pentru a comanda controlerul de temperatură 

 

Acest lucru se realizează din meniul Temp. Controller prin selectarea opŃiunii 

Initialize WinDETA from Controller (fig.12). 
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Fig.11. Setarea valorii de temperatură 

 

 

Fig.12. Configurarea WinDETA pentru a comanda controlerul de temperatură 
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4.7. Salvarea rezultatelor experimentale 

 

Din meniul File se selectează Set File Names pentru a stabili (Set) numele fişierelor 

în care se salvează rezulatele masurătorii (PEJD.eps), mesajele apărute în timpul măsurătorii 

(PEJD.msg), jurnalul de măsurătoare (PEJD.log) şi temperatura (PEJD.tem) (fig.13). 

Mesajul, jurnalul măsurătorii şi temperatura sunt salvate ca fişiere în ferestrele Message, 

Data Log si Temperature Log (fig.14.).  

 

ObservaŃie: In particular, fişierele destinate mesajelor şi temperaturii pot ocupa foarte mult spaŃiu dacă 

sunt salvate. 

 

 

Fig.13. Setarea numelor fişierelor de salvare a rezultatelor 



 12 
 

 

Fig.14. Salvarea numelor fişierelor 
 

4.8. Verificarea setărilor 
 

Pentru a verifica setările impuse măsurătorii, din meniul Measurement se accesează 

opŃiunea Show Definitions, ca în fig.15. Dacă se doreşte modificarea acestor setări, acest 

lucru se poate face folosind paşii descrişi anterior ( 4.1. ÷ 4.7. ). 

 

Fig.15. Verificarea setărilor impuse măsurătorilor 
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4.9. Inlocuirea fisierelor implicite 

 

Pentru a salva toate setările realizate la pasul 4.4., în fişierul prezent, din meniul File 

se selectează Save Preset (fig.16). Acestea pot fi utilizate în măsurători viitoare prin 

înlocuirea fişierelor implicite din meniul File → Load Preset → OK. 

 

 

Fig.16. Salvarea setărilor impuse măsurătorilor 

 

4.10. Demararea măsurătorilor 

 

Pentru a demara măsurătorile, din meniul Measurement se bifează opŃiunea Start 

(Ctrl+R), ca în fig.17.  

 

După accesarea opŃiunii Start, softul WinDETA ne va anunŃa activare încălzirii 

celulei de măsură la temperatura setată, în cazul nostru temperatura stabilită a fost de 300 K 

(fig.18). 
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Fig.17. Demararea măsurătorilor 

 

 

Fig.18. Activare încălzirii celulei de măsură la temperatura setată 

 

 



 15 
 

 

4.11. Finalizarea măsurătorilor 

 

Oprirea ciclului de măsurători se face automat, după realizarea tuturor analizelor în 

condiŃiile (frecvenŃă, temperatură) stabilite anterior. La încheierea măsurătorilor, rezultatele 

precum şi celelalte mesaje înregistrate în timpul măsurătorilor se află salvate în fişierele 

stabilite anterior la pasul 4.1.7. 

Rezultatele obŃinute în urma măsurătorilor sunt afişate în fereastra Online a graficului, 

ca în fig.19. 

 

 

Fig.19. Afişarea rezultatelor obŃinute în fereasta online a graficului 
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4.12. Salvarea şi prelucrarea rezultatelor 

 

a) Din meniul File, se accesează opŃiunea Save Measurement As ASCII (fig.20), şi 

se setează datele de interes ce se vor a fi prelucrate, precum: permitivitatea electrică 

complexă, partea reală ε' şi imaginară ε'', factorul de pierderi Tan(Delta) şi unghiul de pierderi 

Loss Angle (Delta) [Deg], ca în fig.21. Datele sunt salvate ca fişier text.  

 

 

 Fig.20. Salvarea şi prelucrarea rezultatelor obŃinute 
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Fig.21. Salvarea rezultatelor de interes obŃinute 

 

b) Datele astfel salvate pot fi prelucrate cu ajutorul diferitelor programe. În cazul 

analizat, fişierul PEJD.txt, va fi importat în programul Origin, astfel : File → Import → 

Single ASCII, ca în fig.22. Datele importate sunt prelucrate, pentru ca în final graficele dorite 

sa fie afişate ca în fig.23. 
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Fig.22. Importul datelor în programul Origin 

 

 Fig.23. Prelucrarea datelor în programul Origin 

 

 c) În final, se opreşte mai întâi softul WinDETA şi abia apoi spectrometrul dielectric 

NOVOCONTROL.  

 

 


